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Roger Tesch will speak on 
The Treasures of APCUG: Association of Per-

sonal Computer User Groups 
 

Before you come to the meeting, take a look at the AP-
CUG website and come prepared to ask questions of our guest. 
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June at a Glance 

Wisconsin All-computer Users Club 
http://www.wauc.info 

7 WAUC General Meeting, 7:00 PM 
 Jackson Park Lutheran Church 
 4535 W. Oklahoma Ave.  
 Topic—APCUG 
 
13 WAUC Lunch, 1 PM, Old Country  
 Buffet, 4902 S. 74th   
 RSVP:  rgdurand@yahoo.com 
  
13 Mac SIG, 7:00 PM 
 Villa at the Stations, 8935 S. Wood 
 Creek Dr., Oak Creek 
 
14 MS Excel SIG, 7:00 PM 
 Speedway Station, 60th & Layton 
 
15 Deadline for submitting articles
 for WAUCtalk, please send to: 
 ricejulia@hotmail.com  
 Subject:  WAUCtalk 
 

21 Q&A SIG, 7:00 PM 
 Speedway Station, 60th & Layton 
  
 Investment Tracking SIG, 7:00 PM 
 Speedway Station, 60th & Layton 
 Suspended in June and August: 
 next meeting Wed. July 25th 
 
28 Exec. Bd. Meeting, 7:00 PM 
 Doris Regner’s Home 
   
Future Presentations: 
• July—Sign up for picnic eats 
• August—Picnic 
• September—TBA 
• October—Milwaukee PC’s James 

Lisowski 
• November—Bruce’s secret 
• December—Holiday party 

 

WAUCtal
k 

Welcome,  

New  Member 

Robert Bobinger 

MS SIG Changes 

In June, the Microsoft SIG will 
be finishing the Excel 2007 tu-
torial. We will start Windows 7 
in July. 
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President’s Message—Discovers WAUC 34 Yrs Old 
There are many 
unanswered ques-
tions. Who really 
killed JFK? Is there 
actually a Bigfoot? 
When did WAUC 
begin? Well after a 
little research I 
came up with the 

answer to one of them. Thumbing 
through early editions, I came across 
the following in a WAUCtalk Special 
Edition from 1987. At that time we 
were known as the Wisconsin Apple 

Users Club and were dedicated to 
the Apple line of computers. Today 
we are known as the Wisconsin All-
computer Users Club. 
 
"WAUC Wisconsin’s Oldest Apple 
Users Club - No other club can 
make that claim. Formed in 1978, 
we’ve had a lot of time to learn 
what makes a club worthwhile. 
We’re dedicated to leadership with 
innovations like projection moni-
tors and an electronic bulletin 
board. Come help us introduce 

Milwaukee to the next decade of 
personal computing." 
 
So now we know how long WAUC 
has been in existence. I have been a 
member since 1987 and have en-
joyed every minute of it as I hope all 
of you have. Happy 34th Birthday 
WAUC! 

 

Bruce Kosbab 
President 

 

Board Meeting—Can We Get a Wi-Fi Connection?  
The WAUC Board met on the eve-
ning of April 26th at the home of Doris 
Regner and besides Doris, the 
WAUC officers present were Bruce 
Kosbab, Tom Hermann, and Richard 
Durand. Bill Gierach was not present 
due to being with the high-school 
robot- building team he mentors at 
their tournament in St. Louis.  
 
With a club like WAUC there are al-
ways a number of issues to be dealt 
with and this meeting was no excep-
tion. We spent a fair amount of time 
going over the schedule of events for 
the coming month. There was some 
concern that members will be con-
fused about the dates of future SIGs 
due to the re-scheduling for Easter 
that was necessary in April. However 
it was determined that the posted 
schedule in WAUCTalk, the WAUC 
bulletin, and other places is correct 
and that everything that can be done 
to convey the correct information has 
been done.  
 
On this subject, the Board did re-
ceive a letter from a member inquir-
ing why the Speedway meeting room 
was not in use by WAUC that very 
evening, April 26th. A reply has been 
sent explaining that even though the 
meeting room may be unoccupied, at 
the end of each year, WAUC has to 
reserve with Speedway the dates of 
use for the entire following year.  
 
Another issue with the SIGs is the 

expense to WAUC for the internet 
signal from Virgin Mobile. Even 
though it is pretty much a pay-as-you
-go system, it seems it is only 
needed once a month at the Q & A 
SIG and it gets to be a lot for a small 
organization like WAUC. Richard will 
find out more about it from Bill when 
he gets back and also work with Bill 
to see if the internet signal from his 
smartphone can connect to the 
WAUC laptop. If it works, this might 
at least reduce the expense. 
 
Some corrections for next month's 
(May's) issue of WAUCTalk have 
now been made and it is ready to go. 
One of our previous presenters, Joe 
Schoen, has requested that his busi-
ness card ad be removed from 
WAUCTalk and this has been done. 
Another of our presenters, Joe 
Sopczak, will be added but it is on 
dark blue paper and won't show up 
well in our newsletter. We're waiting 
for a lighter version.  
 
Bruce mentioned that there was a 
recent local newspaper article about 
protection from computer viruses and 
a link to this is going to be included 
in the WAUC Bulletin for May. 
 
Some time was spent reviewing the 
situation for presenters at upcoming 
meetings. James Lisowski of Milwau-
kee PC is scheduled for the Septem-
ber meeting, not the October meet-
ing as was previously reported. Our 

resident source for networking, Tom 
Livermore is looking into having a Wi
-Fi signal at the church during WAUC 
meetings so that it will be available 
for the presentations if necessary.  
 
For the June meeting there will be a 
presenter from APCUG, the Associa-
tion of Personal Computer User 
Groups, of which WAUC is a mem-
ber, who will be speaking on the 
many resources available to us. 
Bruce has already found out that AP-
CUG has virtual conferences avail-
able at their website, http://
apcug.net/virtual.  
 
The Excel SIG is close to completing 
all the chapters in the tutorial pro-
gram. It should be wrapped up in 
three months or so. After that, the 
present plan is to start a SIG on the 
new Microsoft Operating System, 
Windows 7, which more and more 
members are getting. With that in 
mind, Ginny Splinter is doing re-
search on the various Windows 7 
tutorial programs available and when 
one is chosen, the Board will ap-
prove the purchase of it.  
 
It was mentioned that the supply of 
WAUC brochures placed in local 
friendly computer stores is running 
low and the brochures themselves 
now have out-of-date information. 
Doris will get some more printed.  
 

(Continued on page 3) 
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Doris also said that fourteen raffle 
tickets remain to be sold for the spe-
cial raffle drawing of the one terabyte 
external hard drive. We will keep an-
nouncing it at the general meetings. 
What we were all most proud of was 
the recent mention of WAUC during 
the Milwaukee PC computer radio 
show on the local station WISN, from 
10:00 to 11:00 on Saturday morn-
ings. Several of us had heard it’ and 

it's very satisfying that all our hard 
work over the years is publicly ac-
knowledged in this way.  
 

Submitted by 
Richard Durand 

Board Meeting Secretary 
 

(Continued from page 2) 

Board Minutes 

Mac SIG—Desktop, Screensaver Preferences Viewed 
Present at the May 
9th meeting were 
Ray Jamroze, Nancy 
Settloch, Dale Voit, 
Beth Lyman, Peter 
Lee, and Julia Rice.  
We picked up where 
we left off last on our 

study of System Preferences in 
Learn Mac OS X Lion. 
 
There are several ways to access 
System Preferences.  The main win-
dow shows all preferences in five 
categories.  The icon for this function 
can be on the dock.  When a spot-
light search is initiated, the sections 
relating to the topic mentioned will be 
highlighted.    The General prefer-
ences start with display options.   
There are options for appearances of 
scroll bars.  Two fingers on a track 
pad also scroll the page.  In a .pdf 
file, one can turn a full page by click-
ing on the scroll bar. Using this op-
tion is less jerky.  The Sidebar icon 
size can be adjusted.  A choice al-
lows one to restore what is on the 
screen when quitting, including open-
ing several web pages.   
 
Desktop and Screensaver.  There 
are varieties of backdrops for the 
screen and screensavers.  Photos 
can be used for either.  Collages or 
mosaics of photos can be used.  
Time can show on the screen also.  
Peter found it frustrating to use ran-
dom photos: you cannot stop the 
photos when you want time to re-
member where and when you took 
them.  And besides, you may have 
great difficulty finding the photo is 

iPhoto.   Hot corners  can be triggers 
for various actions, such as turning 
on the screen saver. 
 
Mission Control is like a fusion of 
Expose + Spaces in  a previous OS.  
There are several key commands 
that can manipulate programs here.  
It allows opening multiple programs.  
By activating Mission Control,  you 
can deal with the one you want.  You 
can activate Quick Look by hitting 
the space bar when you have the 
cursor on a window;  it makes the 
document readable.   There are a 
number of key commands to activate 
it.  Mission Control is used for control 
and navigation of programs that are 
open.   
 
You can open several pages in Sa-
fari and control them, can manage 
multiple desktops, and can open 
separate programs on separate 
desktops.  New desktops are opened 
by clicking on the plus sign in the 
upper left.  You can switch between 
desktops.   
 
This is where hot corners can be set: 
from Mission Control.  There can be 
a desktop in each hot corner. 
 
Language and Text: You can set the 
languages you will use.  From here 
you can use shortcuts for text items 
and set time and date.  Under input 
sources, one finds a Keyboard and 
Character viewer.  This controls  a 
huge selection of characters that can 
be dragged into a document.  We 
also saw how to change the key-
board to another language. 

 
Peter keeps the value of Apple stock 
on his iPhone.  It is the best capital-
ized company in the world now.  It 
increases in value with each new 
product.   
 
We checked Nancy’s computer for 
the threat that was mentioned at the 
WAUC meeting.   She also needed 
to put Sophos anti-virus on.  Julia 
needs to update and get automatic 
scan going. 
 
Certain keystrokes on the Mac are 
valuable to know by heart: Command 
+ tab switches from program to pro-
gram.  Command + Q quits the open 
program instantly.   
 
We checked that Julia’s hotmail ac-
count is in Mail, but there are dozens 

(Continued on page 5) 

WAUCtalk  
 
 
WAUCtalk is a monthly publication of the 
Wisconsin All-computer Users Club.  WAUC 
is a computer club dedicated to promoting 
and instructing the use of computers to 
WAUC members.  Membership in WAUC is 
$25 per year ($12.50 if applying after June 1).  
WAUCtalk is emailed to all WAUC members. 
 
Contributions to WAUCtalk are always 
welcome.  Please submit articles and 
computer artwork before the 15th of the 
month preceding the issue date, except where 
otherwise noted.  Free advertising is available 
to WAUC members.  We are not responsible 
for omissions or errors. 

 

WAUC Officers 
President:  Bruce Kosbab 771-6086 
 bkosbab@milwpc.com   
Vice President:  Doris Regner 545-3897 
 deereg3@gmail.com   
Treasurer:  Thomas Hermann 258-1521 
 singer@execpc.com  
Board Meeting Secretary:  
    Richard Durand                          873-9339 
    rgdurand@bigfoot.com  
Secretary:  
Member-at-Large:  Bill Gierach 421-6827 
 wdgierach@yahoo.com  
Program Chairman:      
 

WAUC Staff 
Editor: Julia Rice 649-9671 
 ricejulia@hotmail.com  
Webmaster:  Tom Livermore 604-0516 
 exyooper@gmail.com  

 

Libraries 
CD:  Tom Livermore 604-0516 
 exyooper@gmail.com  
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Q & A SIG—Studying WAUC CD-of-the-Month 
The WAUC Q & A SIG met again as 
scheduled on April 19th, 2012, with 
about ten WAUC members present. 
Once again the new WAUC laptop 
from Samsung with Windows 7 was 
in use and a variety of computer is-
sues were dealt with.  
 
Richard Durand asked for assistance 
on how to use Unlocker, a utility pro-
gram that appeared on a previous 
WAUC CD of the Month. Unlocker 
closes files on flash drives so that 
they can safely be removed. Bill 
Gierach, at the keyboard as usual, 
found Unlocker using another utility, 
Gizmo, which he uses to pre-
serve a virtual image of the CD 
of the Month on the laptop hard 
drive. From this, Bill installed 
Unlocker but it wouldn't run, ap-
parently because it's an old ver-
sion not compatible with our 
new 64-bit laptop. Bill then 
found another version on the 
Internet to download, unzip, and 
install. Once Unlocker is in-
stalled, one can open “My Com-
puter,” find the flash drive listed, 
right click on it, and then 
Unlocker should be listed in the 
menu that appears.  
 
Richard also asked about an-
other program from the WAUC 
CD of the Month, Downloader 
Accelerator Plus, also known as 
“DAP.” When downloading, a 
little window appears offering a 
choice of regular downloading, or 
accelerated downloading using DAP. 
But when selecting accelerated 
downloading, there is no dialogue 
window appearing to select the loca-
tion for saving the download. Bill ex-
plained that one first has to open up 
the DAP program and set up the 
download preferences and then the 
dialogue box should appear when-
ever downloading.  
 
Ed Marquard has a Windows 7 lap-
top which sometimes gives him a 
dark screen even though it has been 
turned on. The screen will then sud-
denly appear when the laptop touch-
pad is rubbed. Bill said that the ma-

chine might be in hibernation mode 
and he showed that by going to the 
power settings choices found in Con-
trol Panel, the time taken before the 
machine will go into hibernation 
could be reset. Terry Harvey asked if 
the sensitivity of the laptop touchpad 
could be also reset. Bill showed that 
touchpad settings can also be found 
in Control Panel. 
 
Richard had another question on 
Internet security. When going to se-
cure websites, such as for online 
banking or on shopping websites, a 
dialogue window sometimes appears 

asking if only secure items or also 
insecure items should be shown. Bill 
explained that the best way to deal 
with this is to go to the Internet op-
tions on the menu of the browser 
program and reset the security level.  
 
About this time, Bill had to reboot to 
get the Internet signal back. While 
this was in process, Terry asked how 
to use Google Calendar. After we 
were online again, Bill went to 
Google and showed the Calendar 
function. For some reason, the 
Google screen we found had a black 
menu bar that Bill found rather an-
noying and wanted to get rid of. With 
no immediate solution available, Bill 
just entered a question for this into 

the Google search engine and got a 
number of answers. He selected the 
search result giving an answer from 
www.geekosystem.com and got it to 
work.  
 
After this, Bill showed the members 
the browser program from Google 
known as Chrome. He had installed 
it on the new club laptop. It has a 
setting for allowing Google to track 
the physical location of the user and 
to maintain privacy and security, Bill 
recommends disabling this feature.  
 
All the browser programs also have a 

setting allowing automatic 
updates to be downloaded 
and installed and to maintain 
security; this should always 
be enabled.  
 
While on the subject of se-
curity, Bill also informed us 
that some PDF files can be 
infected so that opening 
them will run a malicious 
program. To deal with this, 
open the Adobe Reader pro-
gram and go to the security 
settings under preferences 
in the menu bar. Disable 
Javascript and then re-
enable it anytime it is 
needed for a file that is 
known to be safe and dis-
able it again when done.  
 

Before we knew it, our time for the 
SIG was just about up. As we were 
closing down, Bill was showing us an 
add-on for the Firefox browser called 
“Auto-fill,” a very useful utility that 
once set up will automatically enter 
in one's name, address, and other 
information at online shopping sites 
for example. Anyone using the Fire-
fox browser should consider includ-
ing it. And those were the main top-
ics covered at the WAUC Q & A SIG 
for April 2012. 

Richard Durand 
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Investment Tracking SIG—Two Play Investing 
 
The WAUC Invest-
ment SIG for April 
2012 was held as 
scheduled on April 
25th even though 
only two WAUC 
members, Richard 
Durand and Don 

Gardner, were present. There will be 
one more WAUC Investment SIG on 
May 23rd before the summer break. 
Then the SIG will not meet again at 
the Speedway meeting room until 
September.  
 
However, there will be a special SIG 
meeting on July 25th at the commu-
nity room of Villas at the Station, 
8935 S. Wood Creek Drive, in Oak 
Creek, the residence of the founder 
of the WAUC Investment SIG, Mr. 
Bruce Schneider. This is also the 
same location as that of the WAUC 
Mac SIG. 
 
 
Using the data and charts of his 
online brokerage, www.options-
xpress.com, Richard showed a re-
cent virtual trade he had completed 
using options on the stock of the 
company from which many of us ac-
quired our first computer: Apple. This 
trade was what is known as a credit 
spread, selling one current out-of-the 
money put option and buying the 
next further out-of-the-money put, 
and receiving the difference of fifty 
cents a share. Richard traded five 
contracts of one hundred shares 
each and so received a total of 
$250.00 on an investment of 
$2,500.00 for a period of thirty days, 
and with a probability of no less than 
57%.  

Richard also used online charts to 
illustrate the market exit rules he 
learned about from a representative 
of Investors Business Daily, 
www.investors.com/, at a recent in-
vestment conference in Oak Brook, 
Illinois. There are four things to 
watch for on the price charts and if 
three of these four are observed, 
there is a high probability that the 
market will fall further and exiting 
one's position is a really good idea.  
 
First, see if the security price has 
fallen below its fifty day moving aver-
age. 

Second, observe if there have been 
any recent gap-downs on the price 
chart. A gap-down is when a day's 
price bar is below the closing price of 
the previous day. 

Third, look to see if there has been 
any recent selling volume above the 
fifty day trading volume average. 

And fourth, look to see if the major 
market indexes, such as the Dow 
Jones, the S & P 500, and the 
Nasdaq, are falling. 

To learn more about how to apply 
these rules, consider attending a fu-
ture WAUC Investment SIG and we'll 
go over them again. 
 
It was time to move on to our virtual 
account at www.investopedia.com to 
check on how well our previous se-
lections were doing. The market has 
been rallying recently and so some 
of our stocks are showing some life. 
Toyota Motors, TM, and the Power-
shares NASDAQ Fund, QQQ, have 

positive gains. Don's choice, US 
Ecology, ECOL, is up 24%. The al-
ternative energy selections, Zagg 
Inc., ZAGG, and Advanced Battery 
Technologies, ABAT, continue to 
decline. At the March Investment 
SIG, we added 100 shares each of 
four stocks Don and Dale Voit had 
come across: Amarin Corp., AMRN, 
Krispy Kreme Doughnuts, KKD, In-
ternational Game Technology, IGT, 

and Kors Holding, KORS. After one 
month, they are all down by up to 
4%. The recent market rally that was 
lifting almost everything now seems 
to have stalled.  
 
Don had two more stocks he wanted 
to try so we looked them up and the 
fundamentals and the charts ap-
peared interesting. We entered pur-
chases of 100 shares each of Sta-
ples, SPLS, and RCM Strategic 
Global Government, a bond fund, 
RCS.  
 
And that was what happened at the 
WAUC Investment SIG for April 
2012. We were going to get back to 
watching some instructional videos 
on investing but we ran out of time. 
We'll try to get back to that at the 
next SIG. Until then, consider these 
words of advice for investments and 
life in general: “You'll never go broke 
taking a profit.” 
 

Richard Durand 

of undeleted old emails that need 
work.  These emails had been de-
leted in Hotmail.  Her chosen solu-
tion was to take Hotmail out of the 
Mail program so that she could keep 
the format she wanted. 
 

We talked about closing all programs 
before shutting down as important to 
do.  We also checked on how many 
cycles of power our Macs had gone 
through.  They should be able to go 
through a thousand, but we were 
under two hundred.  A cycle of power 
occurs when the power lowers and 
has to come up again by being 
plugged in. 
 

We reviewed what future topics we 
will study.  We saw a German song 
in Ray’s iTunes and used Google 
Translate to discover the title.  Ap-
parently the Germans use poetic 
words in their songs as we do; the 
translations didn’t always work. 
 

Julia Rice 
 

(Continued from page 3) 

Mac SIG 
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MS Excel SIG—Sorting Tables Clarify Data 
Six members at-
tended the Microsoft 
(MS) Excel 2007 
SIG on Thursday 
March 8, 2012:  Ju-
dith Hornburg, Rich-
ard Durand, Don 
Gardner, Dick and 

Kay Yezek, Bill Gierach, and Ginny 
Splinter.  Because Bill Gierach was 
unable to attend, Don Gardner took 
the club’s projector, old laptop, and 
other parts from the general meeting 
and smoothly hooked up this equip-
ment for our SIG. 
 
Chapter 23 - Creating A Table 

 
Then we covered Chapter 23 on Ta-
bles in our tutorial. Ginny handed out 
a sheet she prepared on the compo-
nents of an Excel Table.  
 
Definition of Table Components 
Note: Database terms are generally 
used for Excel Table components. 
Table - An Excel Table is a table 
stored in a table format; this is a dif-

ferent format than the rest of the 
worksheet.  
Fields - Different types of information 
are stored in table columns called 
Fields. Each Field has separate info.  
Record - Each row in a table is called 
a Record. 
Header Row - Titles of Fields are 
located in the top row or Header 
Row. 
Auto-Filters - Each Field in a Header 
Row has a drop-down menu called 
Auto-Filters to filter the data in the 
table.  
NO Blanks Columns/Rows - In a ta-
ble, you cannot leave an entire row 
or column blank. If you do, Excel 
thinks that this is the end of the table. 
 
Analysis For Table Design  
Before creating a Table in Excel, one 
should think about the info you want 
to collect. Think about the subject 
and then its fields.  
 
Create Data For Table - Enter the 
field titles in the top row or Header 
Row and then enter each Record/
row of data. Use the Tab key to add 
each new Record (row). Records are 
always appended to the previous 
row. Never skip a row. 
 
Edit Data - Select a cell and make 
desired changes. Use Tab key to exit 
or move to next cell. 
 
Insert New Record (Row) - To in-
sert a new Record (row), select the 

row above a new record, right-click, 
and select Insert. Then add the data 
to the new Record (row). 
 
Insert New Field (Column) - To in-
sert a new Field (column), select the 
Field to the right of your new Field, 
right-click, and select Insert. Then 
add the data to the new Field 
(column).  
 
Delete Records/Fields - Select the 
desired Record (row) or Field 
(column), right-click, and select De-
lete. This will remove the entire row 
or column. 
 
Convert Data To Table - To convert 
data to a table, highlight the data 
(including Header Row) and select 
Insert tab. In the Tables group on left 
side, select Table; in the Table Dia-
log Box, select OK. You will notice 
the drop-down menu for each col-
umn name and 2 shades of the de-
fault blue color for the rows. 

 
Chapter 24 - Sorting Data 

 
Next we covered Chapter 24 on sort-
ing data in our tutorial.  
 
Simple Sort - For a simple sort from 
top to bottom, after selecting all of 
your data, in the Data tab and the 
Sort And Filter group, select AZ but-
ton for ascending sort (A-Z, 1-10 or-
der) or ZA button for descending sort 

(Continued on page 7) 
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(Z-A, 10-1 order). 
 
Layered Sort For Columns - You 
can create a layered sort on col-
umns. 
Primary Sort - After selecting your 
entire file, in Data tab and Sort And 
Filter group, select the Sort button.  
In the new Sort Dialog Box and the 
Column Sort By drop-down menu, 
select your desired column for your 
primary sort. To the right of this, for 
Sort On drop-down menu, generally 
select Values (Optionally you could 
select Cell Color, Font Color, or Cell 
Icon). To the right of this, for Order 
drop-down menu, select A to Z or Z 
to A. For an example of the Sort Dia-
log Box, you may refer to Example 
3C - Sort Dialog Box w Icons. 
 
Adding Layered Sorts - To add 
more sorting layers, in the Sort Dia-
log Box, select Add Level. As before, 
select your 3 drop-down menus for 
Column Sort By, Sort On, and Order. 
Repeat this until you have all of your 
levels. If you make a mistake in any 
level, select the level and Delete 
Layer tab. After you are finished, se-
lect OK to apply your sorting. Imme-
diately after a sort, if you made a 
mistake, select the Undo button in 
the top Quick Access Toolbar. 
 
Custom Sort Order 
Definition/Examples - You need to 
create a custom sort order when the 
sorting order isn’t ascending or de-
scending. This custom sort order can 
be used only for primary (first) sort 
level. An example would be using 
text for days of the week (Monday, 

TuesdayU), or months of the year 
(January, FebruaryU) where you 
would want a sort on chronological 
order. Other examples are having 
text for ratings (Low, Medium, High) 
or using conditional formatting to cre-
ate various icon sets (Directional, 
Shapes, Indicators, or Ratings) 
added to your values where you 
want a sort based upon the icon 
sets. 
 
Select Data For Custom Sort Order 
- After selecting all of your data, se-
lect Data tab; in the Sort And Filter 
Group, select Sort button. If you 
have text in a column such as 
months of the year, in the Sort Dialog 
Box, for Column Sort By drop-down 
menu, select Month; for Sort On drop
-down menu, select Values; for Or-
der drop-down menu, select Custom 
List. 
 

Create Custom List Sort Order & 
Sort - Now you will get a Custom 
Lists Dialog Box. You may refer to 
Example 2A1 - Custom Sort List Dia-
log Box. If your custom sort order is 
in the left Custom Lists box, select it. 
If your custom sort order is not in the 
left Custom Lists box, enter the info 
in the List Entries box and select 
Add. Then select OK for the Custom 
List Dialog Box, and OK for the Sort 
Dialog Box to complete your sort.  
 
Delete Your Custom List Sort Or-
der - While you are viewing the Cus-
tom Lists box, you can delete any 
custom list you have created. You 
may refer to Example 2A1 - Custom 
Sort List Dialog Box. To do this, se-
lect a custom list you created, and 
the Delete (on the right) and OK to 
verify your delete request. Then se-
lect OK and OK.  
 
Now we tried out the new information 
we learned. 
 

Examples 1 - Table 
 

Example 1A Basic Data - I created 
basic data for a book discussion 
group attendance. See Example 1A - 
Basic Data Book Discussion Group 
2010.  
 
Example 1B Basic Data w Rate - 
To the left of the Total column, I 
added a new column labeled Rate to 
rate attendance as Low, Medium or 
High. This was done using condi-
tional formatting with icon sets to 

(Continued from page 6) 

(Continued on page 8) 
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group the attendance number in the 
Total column into 3 icon shape colors 
and its values. After looking at the 3 
icon shape colors, I entered in the 
new Rate column “Low” for the red 
icon, “Medium” for the yellow icon, 
and “High” for the green icon. Then I 
removed the 3 icon colors from the 
Total column. See Example 1B - Ba-
sic Data w Rate Book Discussion 
Group 2010.  
 
Example 1C Basic Table - Then this 
data is converted into an Excel Ta-
ble. After selecting only the data 
(including the Header Row), select 
Insert tab. In the Tables group on left 
side, select Table; in the Table Dia-
log Box, select OK. You will notice 
the drop-down menu for each col-
umn name and the horizontal rows in 
the default 2 shades of blue. See 
Example 1C - Basic Table Book Dis-
cussion Group 2010. 
 

Example 2 - Sort 
 

We practiced creating a layered sort 
using the Sort Dialog Box. Then we 
focused on creating custom sorts. 
 
Example 2A Basic Table BEFORE 
Custom Sort - I created a basic ta-
ble before a custom sort for a book 
discussion group attendance. See 
Example 2A - Basic Table BEFORE 
Custom Sort Book Discussion Group 
2010. 
 
Example 2A1 Custom Sort Dialog 
Box - Then we created a custom 
ascending sort based on ratings. Af-
ter selecting the data, select the Data 

tab; in the Sort And Filter group, se-
lect Sort button. In the Sort Dialog 
Box and its Column Sort By drop-
down menu, select Rate; for Sort 
drop-down menu, select Values; for 
Order drop-down menu, select Cus-
tom List. In the Custom List Dialog 
Box and its List Entries box, enter 
“Low,Medium,High” and select Add. 
See Example 2A1 - Custom Sort 
Dialog Box. 
 
Example 2B Basic Table AFTER 
Custom ASCENDG Sort - Then se-
lect OK and OK to complete your 
custom sort. See Example 2B - Basic 
Table AFTER Custom ASCENDG 
Sort. 
 
Custom Descending Sort - To cre-
ate a custom descending sort with 
the above data, repeat the steps 
above, but enter “High,Medium,Low” 

in the List Entries box of the Custom 
List Dialog Box. 
 
Example 3 - Sorts Creating Groups 

For Columns 
 

While working with sorts, we dis-
cussed dividing the values of a col-
umn into groups. 
 
MORE Work/Creating Groups - 
One way is to create your custom 
groups. After selecting your column 
of values, in the Home tab and the 
Styles group, select Conditional For-
matting and Highlight Cell Rules. 
One would have to use the various 
arithmetic operators (<, >, =, etc.) to 
create each custom group. Then you 
indicate the color text, color fill, color 
border and other options. This takes 
a lot of work! 
 
LESS Work/Using Excel Icon Sets 
Another way is to have Excel divide 
your column of values into groups. 
After selecting your column of val-
ues, in the Home tab and the Styles 
group, select Conditional Formatting 
and Icon Sets. Then select Direc-
tional, Shapes, Indicators, or Ratings 
and the specific one you desire. De-
pending upon your selection, Excel 
will automatically divide your values 
into 3 to 5 groups.  
 
Example 3A Conditional Format-
ting, Icon Sets - Using Example 1A - 
Basic Data Book Discussion Group 
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2010, select Total column; in the 
Home tab and Styles group, select 
Conditional Formatting, Icon Sets, 
and Shapes, and the first choice on 
the left side.  See Example 3A - Con-
ditional Formatting, Icon Sets. 
 
Example 3B Basic Data w Icons - 
You will have created your basic file 
with icons. See Example 3B - Basic 
Data w Icons Book Discussion Group 
2010.  
 
Sort Dialog Box w Icons - We want 
to sort this file by the 3 selected 
icons in the Total column. After se-
lecting all of the data, in the Data tab, 

select the Sort button. In 
the Sort Dialog Box, se-
lect Add Level tab for the 
primary sort level. For 
the Column Sort By drop
-down menu, select To-
tal column; for Sort Or-
der drop-down menu, 
select Cell Icon; for Or-
der drop-down menu, 
select the red icon and 
On Top. Then select the 
Add Level tab for the 
secondary sort level. For 
the Column Then By 
drop-down menu, select 
Total column; for the 
Sort On drop-down 
menu, select Cell Icon; 
for the Order drop-down 
menu, select the green 
icon and On Bottom. See Example 
3C - Sort Dialog Box w Icons. 
 
Example 3D Basic Data w Sorted 
Icons - Then select OK. You have 
created the basic data with sorted 
icons. See Example 3D - Basic Data 
w Sorted Icons Book Discussion 
Group 2010. 
 

Example 3E Basic Data w Sorted 
Icons,Value - To have this file in 
sorted order by color icon and its 
value, select the entire data. Then 
select the Data tab and Sort button. 
In the Custom Sort Dialog Box, for 
Column Sort By drop-down menu, 
select Total; for Sort On drop-down 
menu, select Values; for Order drop-
down menu, select Smallest to Larg-
est. Then select OK. See Example 
3E - Basic Data w Sorted cons,Value 
Book Discussion Group . 

Ginny Splinter 
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Example 2A1 - Custom Sort  

List Dialog Box 
 

Example 3A - Conditional Formatting, 

Icon Sets 
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